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CHAPTER 1: CARSON CASE STUDY GUIDE
Upon completion of this case study, you will be able to:

l enter basic data from the Organizer and other source documents

l navigate through the tax system

l review the return using the Tax Forms

l compare your answers to a correctly completed return.

Click here to view and download a PDF of the guide, including the source documents.

INTRODUCTION
The Carson case study is designed for someone new to the tax software. The case study steps through the
basics of preparing a return using the tax application and teaches many aspects of navigation and review. This
training return provides hands-on data entry experience for a variety of tax topics such as entering wages,
adding a business, and entering depreciation.

l Carson Tax Return Scenario (page 4)

o The Organizer Booklet (page 4)

o Items To Note (page 4)

l Screen Components (page 6)

o Forms List Window (page 6)

o Organizer Screen (page 7)

o Tax Forms Screen (page 8)
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2 Chapter 1: Carson Case Study Guide

Introduction

l Data Entry (page 9)

o Organizer Booklet (page 9)

o Source Documents (page 9)

o Entering Information (page 10)

n Basic Return Information (page 10)

n Employer Information (page 12)

n Wage Income (page 12)

n Interest and Dividend Information (page 13)

n Capital Gains and Losses (page 14)

n Schedule C Business Information (page 14)

n Schedule C Business Income and Expenses (page 15)

n Mortgage Interest and Real Estate Taxes (page 15)

n Charitable Contributions (page 15)

l Reviewing the Return (page 16)

o Diagnostics (page 16)

n Viewing Diagnostics (page 16)

n Suppressing Diagnostics (page 18)

o Overrides (page 18)

n Clearing Overrides (page 19)

n Deleting Overrides (page 19)

o Comparison (page 19)

o Printing the Carson Return (page 19)

l Creating Training Returns (page 21)

l 1040 Carson Case Study Facts (CASCAM) (page 22)
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Introduction

l Paper Organizer
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CHAPTER 2: CARSON TAX RETURN
SCENARIO
Frank and Marilyn Carson are sample clients. You are going to prepare their 2019 return using GoSystem Tax.
The Carsons have completed an Organizer booklet that contains most of the information you need to complete
this training return. Some of the information already appears in the tax return since this return was completed
by your firm last year. Other information you will have to enter.

THE ORGANIZER BOOKLET
Begin by reviewing the Carsons’ Organizer booklet information. Here are some things to note in the information
that will be important when you enter data into the tax application.

l Some information is rolled over from 2018. You will need to verify this information.

l There are some items you will have to add to the return.

l There are some proforma’d items that rolled over from 2018 that you will need to delete to complete the
return.

ITEMS TO NOTE
l Marilyn Carson changed jobs in 2019.

l The Carsons closed a bank account in 2018, that has proforma’d to 2019. Delete the proforma’d data that
does not pertain to 2019.

l A consolidated 1099 was added in 2019, which includes dividend income and capital gains and losses.

l Marilyn Carson started a small business, so you will need to add a new Schedule C.

l The Schedule C business has an asset, so you will need to depreciate it.

l The Carsons had capital gains and losses.

l The Carsons had various itemized deductions.

Normally when information is proforma’d from the prior year, the address information, martial status, and
dependent information would roll over. For case study purposes, you will need to enter and verify this
information.

GOSYSTEM TAX
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5 Chapter 2: Carson Tax Return Scenario

Items To Note

For navigation, see Screen Components (page 6). For data entry techniques, see Data Entry
(page 9).
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CHAPTER 3: SCREEN COMPONENTS

FORMS LIST WINDOW
The Forms List Window is used to access theOrganizer and Tax Form screens. The Forms List Window
is similar to other file management systems.Organizer and Tax Forms reside within a hierarchical
arrangement of folders that can be expanded and collapsed for convenient viewing and access. The folders
expands to show additional folders and page icons. A single-page icon indicates one screen for data entry,
while the multi-page icon indicates multiple screens or tabs for data entry. Multi-page Organizer screens use
tabs to access these additional pages.

Two Forms List tabs,Organizer and Tax Forms, provide separate lists for their respective contents. You
can open a folder,Organizer screen, or Tax Form screen by selecting the item in the list. When you open an
Organizer screen or Tax Form screen, it appears in the Forms List pane on the right.

GOSYSTEM TAX
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7 Chapter 3: Screen Components

Organizer Screen

ORGANIZER SCREEN
Information you enter inOrganizer screens flows to the actual tax return.

Figure 3:1
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Chapter 3: Screen Components 8

Tax Forms Screen

TAX FORMS SCREEN
Tax Forms screens are on-screen facsimiles of the actual federal and state tax forms that are reproduced for
the tax return.

Figure 3:2
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CHAPTER 4: DATA ENTRY

ORGANIZER BOOKLET
To begin, verify or enter all the data from theOrganizer booklet. At the bottom of eachOrganizer page, the
navigation to that data entry screen is shown. Start by clicking theOrganizer tab and selecting the applicable
Organizer screen.

Figure 4:1

SOURCE DOCUMENTS
The source documents detail the items and information that must be entered in the return. Use these
documents to enter the data in the Organizer.

GOSYSTEM TAX
1040: CARSON CASE STUDY



10 Chapter 4: Data Entry
Entering Information

Figure 4:2

ENTERING INFORMATION

Basic Return Information
To begin, verify or enter the data from the Organizer booklet that relates to General Information. Start by
clicking theOrganizer tab and selecting the applicableOrganizer screen.

GOSYSTEM TAX
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Chapter 4: Data Entry 11
Entering Information

1. SelectGeneral Information > Basic Return Information > Taxpayer Information.

2. Verify all the taxpayer information listed in the Organizer booklet, and add or change any applicable
information.

Figure 4:3
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12 Chapter 4: Data Entry
Entering Information

3. Continue entering all data from each Organizer booklet page using the source documents until you have
completed the date entry for the return. All of the information in this section relates to the Organizer
booklet and source documents.

Filing Status ismandatory and must be entered.

4. Enter or verify that all the dependent information shown here appears in the tax application. Both
dependents lived with their parents for the full 12 months. No entry is required, as 12 months is the default.

Employer Information
Since Marilyn did not work for Kelly Services in 2019, the wage information should be deleted.

1. ClickKelly Services on the Forms List window.

2. Press the Delete key on the keyboard.

3. ClickOK.

Since Marilyn changed employers in the current tax year, you must add a new employer to the return.

1. From the Employer Name list, selectAdd new Employer Name.

2. Enter Smith Barney in the Add new Employer Name dialog box.

3. Select the Spouse option.

4. Enter Marilyn's wage information.

Wage Income
1. SelectOrganizer > Income > Wages and Salaries > Wage Input.

2. Select the employerMajor Supplier.

3. On the facts that you printed out, find Frank Carson's gross wages from Major Supplier. Type that amount.

4. Enter the federal tax withheld.

5. Enter the amount of wages subject to Social Security tax.

6. Enter the Social Security tax withheld.

GOSYSTEM TAX
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Chapter 4: Data Entry 13
Entering Information

7. Enter the amount of wages subject to Medicare tax.

8. Enter the amount of Medicare tax withheld.

9. Enter the state zip or postal code in the 2-digit field and then type the amount of state tax withheld.

10. SelectKelly Services.

11. Since Marilyn did not work for Kelly Services in the tax year, press the Delete key on the keyboard to
delete Kelly Services from the return. ClickOK to confirm the deletion.

Make sure thatCompute is off. To do so, selectCompute > Auto Compute to turn the
Compute option on or off.

Interest and Dividend Information
Include the couple’s interest income in the return.

1. SelectOrganizer > Income > Interest Income > 1099-INT.

2. SelectNorwest Bank and then enter the interest income not included in Box 3.

3. SelectAmerican Savings, and then enter the interest income not included in Box 3.

4. Remove First Interstate from theOrganizer screen. To do so, select First Interstate. Then select
Delete.

Include the couple's dividend income in the return.

1. SelectOrganizer > Income > Dividend Income > 1099-DIV > New Dimension.

2. Enter the amount for Ordinary Dividends in theOrdinary Dividend field.

3. Enter the amount for Capital Gain Distributions in the Total capital gain distribution field.

4. From the Dividend Input list, selectAdd new 1099-DIV payer.

5. Enter Hyte Fund in the Add new 1099-DIV payer dialog box.

6. SelectOK.

7. Enter the amounts forOrdinary Dividends and Total capital gain distributions as you did in steps 2
and 3.

The Carsons entered into a new investment in the current tax year called the Hyte Fund. You must

Dividend income carries to Schedule B and capital gains information carries to Schedule D.

GOSYSTEM TAX
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14 Chapter 4: Data Entry
Entering Information

Capital Gains and Losses
Capital gains and losses should be entered in theGains and Losses folder. The gains and losses that relate
to the Consolidated 1099 should be entered in that screen.

1. SelectOrganizer > Gains and Losses > Capital Gains and Losses > Add new Description of
Property.

2. Enter New Dimensions Fund in the Add new Description of Property dialog box.

3. Enter the date acquired and date sold in the Date acquired and Date sold fields.

4. In Computation of Gain(Loss), enter the sale proceeds in the Proceeds (sales price) field.

5. In Computation of Gain(Loss), enter the cost in the Cost or other basis field.

Each activity has a folder for enteringGains and Losses that relate to that activity. For gains and
losses that do not relate to a particular activity, scroll down and enter them in the mainGains and
Losses folder.

Schedule C Business Information
In 2019, Marilyn Carson started a small business, which is reported on Schedule C.

1. SelectOrganizer > Income > Business Income > Add new Business Name.

2. In the Add new Business Name dialog box, type Craftiques (the name of Marilyn's new business), and
then clickOK.

3. Enter 001 in the Activity number field.

4. Select the Spouse option to indicate that this Schedule C belongs to Marilyn.

5. Verify that the Accounting Method isAccrual. If not, change it to Accrual.

6. Verify that the Inventory Valuationmethod isCost.

7. Verify that under Income Type, the Taxpayer materially participates option is selected.

8. Select the option to indicate that Marilyn's business was acquired during the year of the return.

GOSYSTEM TAX
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Chapter 4: Data Entry 15
Entering Information

Schedule C Business Income and Expenses
Enter the business information and income and expenses for Marilyn’s new company, including the depreciable
asset.

1. Include Marilyn's business expenses in the tax return.

2. Select the Income/Expense tab in the Craftique Organizer.

3. Enter the income and expenses listed in the facts that you printed out.

4. Enter the depreciation for Marilyn's computer in the Business Income section of the Organizer.

5. SelectDepreciation and Amortization > Asset Detail > Add New Asset.

6. Enter the depreciation information from the facts that you printed.

Mortgage Interest and Real Estate Taxes
Mortgage interest and real estate taxes should be entered in the 1098 folder.

1. SelectOrganizer > Itemized Deductions.

2. Select Form 1098 - Mortgage Interest.

3. SelectAdd New Form 1098 - Mortgage Interest.

4. Enter the mortgage interest and tax amounts.

Charitable Contributions
Charitable contributions should be entered under Contributions.

1. SelectOrganizer > Itemized Deductions.

2. SelectContributions Current Year, and enter the cash contributions.

3. SelectMiscellaneous-2%, and enter the amount of the tax preparation fees.

GOSYSTEM TAX
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CHAPTER 5: REVIEWING THE RETURN
The tax preparation process includes thorough review to ensure complete and accurate information on the
return. System tools and features let you locate errors and verify data. You can view the complete return online
and make corrections before printing.

The return must be fully computed after all information has been entered. SelectCompute > Full
Recompute.

1. Review diagnostics and overrides (described in the next section).

2. Review the Tax Forms.

3. Review the supporting work papers.

4. Review the return through print preview.

5. Enter any corrections or changes before printing the return.

DIAGNOSTICS

Viewing Diagnostics
The following directions and windows guide you through the process of viewing diagnostics in the tax
application.

1. SelectCompute > Full Recompute to recompute the return, if necessary.

2. Click theOrganizer or the Tax Forms tab on the Forms List Window.

GOSYSTEM TAX
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17 Chapter 5: Reviewing the Return

Diagnostics

3. Select View > Diagnostics.

Figure 5:1
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Chapter 5: Reviewing the Return 18

Overrides

4. Select the diagnostic description box or highlight the specific diagnostic and click the diagnostic to go to
the input field.

The diagnostic types are:

l Severe: errors that have a negative impact on the computation of the return. These errors must be
corrected and the return recomputed before the return will be correct.

l Informational: explanations and assumptions made during the compute process. These provide
information and have no negative impact on your ability to properly compute the tax return. Review
these diagnostics to be sure the proper assumptions were applied. If not, modify your input for the
item and recompute the tax return.

l E-file: errors or omissions that affect the application’s ability to create an electronic data file for use in
e-file. Each of these diagnostics must be corrected and the return recomputed for an electronic data
file to be created. These errors prevent the return from being available for e-file.

5. Complete or correct the data as needed on the Organizer.

6. Repeat the steps to review the next diagnostic message for this return.

Preparers have the ability to “clear” or “suppress” diagnostics. However, all diagnostics will print. The “cleared”
or “suppressed” diagnostics print with an asterisk “*” in front of the diagnostic. If you are printing diagnostics for
a state, only that state’s diagnostics will print.

Suppressing Diagnostics
1. Select View > Diagnostics.

2. Navigate to the All tab.

3. Place a check mark in the box next to the diagnostic you wish to suppress.

OVERRIDES
When reviewing Tax Forms, look for any field that has a blue or red asterisk (*), which marks an override. You
should have no overrides from your data entry if you have been entering data through Organizers.

GOSYSTEM TAX
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19 Chapter 5: Reviewing the Return

Comparison

Clearing Overrides
1. Select View > Overrides.

Figure 5:2

2. Follow the on-screen instructions to clear the override.

Deleting Overrides
1. Click the Organizer field with the override.

2. Right-click and selectClear Override.

COMPARISON
When the case study is completed, you can compare your entries with the master return that Thomson Reuters
completed using the same data. To compare the Carson return you prepared to the master, selectCase
Study Comparison from the Help menu.

Differences between the amount in your return and the amount in the master return are noted in the
Difference column. There should be no amounts in the Difference column if you entered the data correctly.

There should be no overrides in the return if all entries are made through the Organizer screens. If you have
differences on the case study comparison screen, open the Master Carson case study and compare the
Organizer screens to your screens.

PRINTING THE CARSON RETURN
You can print the Carson return in several ways.

GOSYSTEM TAX
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Chapter 5: Reviewing the Return 20

Printing the Carson Return

Printing from Print Preview
While viewing the Preview Return version of the return:

1. Select Print. Doing so allows you to print the completed tax form you are viewing.

2. When the Print dialog box opens, make the selections you want.

3. SelectOK.

Selective Printing from Print Preview
1. Select the form that you wish to print on the Forms List Window.

2. Select Print.

3. When the Print dialog box opens, select the current selection.

4. SelectOK. You will print the completed tax form that you selected.

GOSYSTEM TAX
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CHAPTER 6: CREATING TRAINING
RETURNS
To complete a case study, you need to create a new return:

1. On the top menu, selectHelp > Case Studies > New.

2. Set the Tax Year to 2019

3. Select the master case study that you wish to clone, and enter a name for your return. For example, if you
select the Carson Case Study, enter XXCARSON as the name of your return (where XX represents your
initials). Include the case name in the Name field to identify the case data duplicated into the return.

New case studies automatically assign the person who creates them as the preparer.

4. Enter a password if desired, and then re-enter the password to validate it.

5. SelectAdd.

6. Your newly created case study will be queued for addition.

7. To access your new case study, selectHelp > Case Studies > Preparer.

8. Select 2019 for the tax year.

9. Select yourself as the preparer.

10. ClickContinue.

11. A list of your cloned case studies appear. Select the case study you wish to work on, and click the locator
number in the second column.

12. Your case study return opens.

GOSYSTEM TAX
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CHAPTER 7: 1040 CARSON CASE STUDY
FACTS (CASCAM)

l Frank B. &Marilyn S. Carson

l 1040 Learning Return for 2019

Frank and Marilyn Carson are sample clients. You are going to prepare their 2019 return using the tax
application. The Carsons completed an Organizer.

The Carson case study is designed for someone new to the tax software. The case study steps through the
basics of preparing a return using the tax application and teaches many aspects of navigation and review. This
training return provides hands-on data entry experience for a variety of tax topics such as entering wages,
adding a business, and entering depreciation.

The Carson Case Study Guide (page 1) contains completed facsimiles of the Carsons’ Organizer and
source documents.

TARGETED AREAS
l Taxpayer/dependents

l Wages

l Interest

l Dividends

l Schedule C income

l Depreciation

l Capital gain/loss (stocks)

l Itemized deductions

l Charitable contributions

GOSYSTEM TAX
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23 Chapter 7: 1040 Carson Case Study Facts (CASCAM)

Data Entry Areas

DATA ENTRY AREAS
l Return Information (page 23)

o Taxpayer Information (page 23)

o Dependent Information (page 24)

o W-2 Information (page 25)

l Income Information (page 26)

o Interest Income (page 26)

o Dividend Income (page 27)

o Business Information (page 27)

o Depreciation Information (page 28)

o Capital Gains and Losses (page 29)

l Itemized Deductions (page 30)

l Filing Instructions (page 31)

l Reviewing the Return

RETURN INFORMATION

Taxpayer Information
1. SelectQuick Track > Basic Return Data.

OR

SelectGeneral Information > Basic Return Information > Taxpayer Information.

GOSYSTEM TAX
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Chapter 7: 1040 Carson Case Study Facts (CASCAM) 24

Return Information

2. Enter the following information:

TAXPAYER SPOUSE

NAME Frank B Carson Marilyn S Carson

ADDRESS 5473 W. Second Avenue
Minneapolis, MN 55417

TELEPHONE NUMBERS Home (612) 111-1111

Business (612) 222-2222

DATE OF BIRTH 01/10/1969 03/01/1972

SSN 845-52-8589 869-94-5967

OCCUPATION Manager Secretary

CONTRIBUTE TO PRESIDENTIAL
CAMPAIGN?

Yes Yes

3. Verify thatMarried filing joint is selected. The filing status is amandatory entry on the 1040 return.

Dependent Information
1. SelectQuick Track > Dependent Information.

OR

SelectGeneral Information > Dependents > Dependent Input > Add new First Name.

2. Add the following dependents:

NAME DATE OF
BIRTH

SSN

Craig A 10/10/2001 863-19-4662

Karen C 06/01/2010 863-24-8813

GOSYSTEM TAX
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25 Chapter 7: 1040 Carson Case Study Facts (CASCAM)

Return Information

3. Both dependents lived with their parents for the full 12 months (no entry required, 12months is the
default).

W-2 Information

Taxpayer W-2 Information

1. SelectQuick Track > W-2 Wages & Salaries.

OR

Select Source Documents (W-2, 1099s, 1098) > W-2.

2. SelectMajor Supplier, and enter the following:

EIN 75-4321233

State EIN 54-6666666

Address: 100 Main Street, Minneapolis, MN 55417

3. Select Taxpayer from the radio button choices.

4. Enter the following. Social Security and Medicare Wages are the same asWages.

Wages $45,895

Federal W/H $ 9,179

Social Security W/H $ 2,845

Medicare W/H $ 665

State W/H $ 2,295

Spouse W-2 Information

1. Since Marilyn did not work for Kelly Services in 2019, that wage information should be deleted. Click Kelly
Services from the Forms List window. Press the Delete key. A pop-up window asks you to confirm your

GOSYSTEM TAX
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Chapter 7: 1040 Carson Case Study Facts (CASCAM) 26

Income Information

selection. ClickOK.

2. SelectAdd new Employer Name.

3. Enter Smith Barney.

EIN 75-5553211

State EIN 54-4545454

Address 5473 W. Second Ave., Minneapolis, MN 55417

4. Click the Spouse radio button.

5. Enter the following for Smith Barney. Social Security and Medicare Wages are the same asWages.

Wages $26,758

Federal W/H $ 4,013

Social Security W/H $ 1,659

Medicare W/H $   388

State W/H $   803

INCOME INFORMATION

Interest Income
1. SelectQuick Track > 1099-INT Interest.

OR

Select Source Documents (W-2, 1099s,1098) > 1099-INT/1099-OID.

2. Enter the following 2019 amounts. These interest items are owned jointly.

Norwest Bank $ 493

GOSYSTEM TAX
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27 Chapter 7: 1040 Carson Case Study Facts (CASCAM)

Income Information

American Savings $ 289

3. Click First Interstate and press the Delete key to remove this line item from the Organizer screen.

Dividend Income
1. SelectQuick Track > 1099-DIV Dividends.

OR

Select Source Documents (W-2, 1099s, 1098) > 1099-DIV.

2. Enter the following for New Dimension Fund:

Ordinary Dividends $ 118

Capital Gain Distributions $ 348

3. SelectAdd new 1099-DIV Payer.

4. Enter Hyte Fund and clickOK.

5. Enter the following:

Ordinary Dividends $  12

Total Capital Gain Distribution $ 276

The dividend income carries to Schedule B, and the capital gains distribution information carries to
Schedule D.

Business Information
Marilyn Carson started a small business in 2019, which will be reported on Schedule C.

1. SelectQuick Track > Business Income.

OR

Select Income > Business Income > Add new business name.

GOSYSTEM TAX
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Chapter 7: 1040 Carson Case Study Facts (CASCAM) 28

Income Information

2. Enter Craftiques and clickOK.

Craftiques is now listed under Business Income.

3. Click the Spouse radio button to indicate that this Schedule C belongs to Marilyn.

4. Enter the Business Address: 5473 W. Second Ave., Minneapolis, MN 55417.

5. Enter the Principal Business Code: 453220.

6. Verify under the Sch C Miscellaneous Info tab that the Accounting Method isCash and the
Inventory Valuationmethod isCost.

7. Verify under Income Type that Marilyn Carsonmaterially participates.

8. Verify the At Risk Information: All at risk.

9. Check underMiscellaneous Information that the business was acquired during the year.

10. To enter business income and expenses, click the Income/Expenses Detail tab at the top of this form.

11. Enter $ 19,150 Sale of Crafts forGross Receipts or Sales Detail.

12. Click the Sch C Inc/Exp tab.

13. Enter the following:

Purchases less cost of items withdrawn for personal use $ 9,750

Inventory at end of year $ 2,975

Advertising $    100

Insurance $    550

Legal and professional services $    400

Depreciation Information
The depreciation on the laptop that Marilyn Carson uses for her business should be entered on the Business
Income part of the Organizer.

GOSYSTEM TAX
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29 Chapter 7: 1040 Carson Case Study Facts (CASCAM)

Income Information

1. SelectDepreciation and Amortization > Asset Detail > Add new Asset.

2. Enter Laptop Computer and clickOK.

3. Enter the following asset information:

Date placed in service 04/15/2019

Cost $ 2,500

Method 5 year MACRS

Drop-down lists of alternative tax treatments facilitate entering assets for depreciation.

Leave the Life field blank. The system, by default, uses the 5-year life for 5 Year modified
accelerated cost recovery property.

4. Since the laptop was used only 75% for business, scroll to the Business Percent and Salvage Value
section.

5. Enter .75 in the Business use % if not 100% field.

The asset is over 50%business use. However, for this training return, guidance in selecting a
Property Type option will not be provided.

Capital Gains and Losses
1. SelectQuick Track > Capital Gains and Losses.

OR

SelectGains and Losses > Capital Gains and Losses > Add new Description of Property >

GOSYSTEM TAX
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Chapter 7: 1040 Carson Case Study Facts (CASCAM) 30

Itemized Deductions

Capital Gains and Losses.

2. Enter the following information: (Joint Ownership):

DATE
ACQUIRED

DATE
SOLD

SALES
PROCEEDS

COST

NEW DIMENSIONS FUND 03/05/2012 08/01/2019 $1,204 $  896

HYTE FUND 04/17/2010 09/15/2019 $1,586 $1,493

VARIOUS 12/05/2015 03/01/2019 $ 345 $ 427

Each activity has a folder for entering gains and losses that relate to that activity. For gains and
losses that do not relate to a particular activity, enter them in the mainGains and Losses folder.

ITEMIZED DEDUCTIONS
1. SelectQuick Track > 1098 Mortgage Interest.

OR

Select Itemized Deductions > Taxes and Interest > Columnar Input – Form 1098.

2. If you use Quick Track, selectAdd new 1098 - Mortgage Interest & T.

3. EnterMortgage Lender’s Trust.

4. Enter Mortgage Interest (Joint): $9,683.

5. Enter Real Estate Taxes Paid: $1,164.

You can use Previous and Next to page through all the forms screen by screen.

6. Select Itemized Deductions > Contributions > Contributions - CY and Carryovers.

GOSYSTEM TAX
1040: CARSON CASE STUDY



31 Chapter 7: 1040 Carson Case Study Facts (CASCAM)

Filing Instructions

7. Enter for Current-Year Cash Contributions (Joint):

United Way $  50

Church $ 600

Miscellaneous Charities $ 125

8. Enter 60% as limitation.

FILING INSTRUCTIONS
1. Select Quick Track > Letters & Filing Instruct.

OR

Select Letters and Filing Instructions > General Options.

2. Select Transmittal Letter and Filing Instructions.

This activates the filing instructions by referring to the taxpayer address already entered. You can
override the selection by clicking the Preferences tab and choosing from the drop-down list titled
IRS Service Center (Override).

GOSYSTEM TAX
1040: CARSON CASE STUDY





Taxpayer Information

Personal Information

First name Last name Social Security NumberInitial M/F

1TP

2SP
Street address Apt. number

3

4

State Zip code CountyCity

5

Foreign Country Foreign Province Foreign Zip code

6

Home/Cell Business/Cell Ext FaxPreferred:
Taxpayer Telephone ( ) ( ) ( )

7

Spouse Telephone ( ) ( ) ( )
8

E-Mail Address 9

X if you want your tax return mailed to a different address. (Provide details on a continuation sheet.)

X if you authorize taxing authority to discuss return with paid preparer

X if you don’t want state tax forms mailed to you next year

10

11Federal State

12

Filing Status - Form 1040 - U.S. Citizen or Resident Alien
Indicate X for marital status at 12/31 (1040NR filers use the Taxpayer Information - Nonresident Alien form):

Single 13

Married, filing jointly 14

Married, filing separately 15

Head of household (Unmarried and providing more than half the cost of a home for a

dependent or unmarried child) 16

Widow (widower), as of 2017 or later, who maintained a home as the principal place of

residence for a dependent child, stepchild, adopted child or foster child 17

Head of Household or Qualifying Widow(er)
Indicate the name of the qualifying child who is not a dependent 18

Social security number of qualifying child 19

Taxpayer Spouse
General

20

21

Occupation:

Date of birth:

Date of death:

Disabilities:

22

23

24

Blind Deaf Totally Disabled Quadriplegic Blind Deaf Totally Disabled Quadriplegic

Paraplegic/Quadriplegic/Hemiplegic Other Paraplegic/Quadriplegic/Hemiplegic Other

25

26

27

Contribute to Presidential Campaign Fund Yes No Yes No

Information for Direct Deposit of Refund

Account typeRouting number (should be 9 digits)

Refunds will be deposited into your
checking account. If you prefer a
savings account deposit, please
indicate with an X

Account number
(Attach a voided check)

If you want to direct your refund to more than one bank account (up to three in total) or to
Purchase Savings Bonds with your refund, please indicate such on the continuation sheet. 28

Organizer General Information Basic Return Data Taxpayer Information

Page 1
R9011 2.000



Dependent Information

Dependents
In general, individuals may not be claimed as a dependent, unless:

1) they were a U.S. citizen or a U.S. legal resident, and

2) you provided over half of their total support in 2019, and
No. of3) they had gross income of less than $4,200 and was your qualifying relative, or, the individual was your child and

months
a) Your child was under age 19 at the end of 2019, or

lived in
b) Your child was under age 24 at the end of 2019 and was a student for any 5 mos. Dependency relationship your home Child care

son, other, grandchild, in 2019, expenses
DateIndicate: T = Taxpayer, S = Spouse, J = Joint etc. (indicate with *if born and incurred

Social security of dependent is part of died in the and paid

L
First name Last name number non-custodial agreement) same year in 2019*birth

1

2

3

4

5

6

* Provide details on the Child and Dependent Care Expenses form, if provided, or on a continuation sheet.
Only include expenses incurred prior to each dependent’s 13th birthday.

Organizer General Information Dependents Columnar Dependents Entry

Miscellaneous Information
In this section, taxpayer may refer to your minor child.

7Indicate: X if taxpayer can be claimed as a dependent on another’s return
Basic Return Data Taxpayer InformationOrganizer General Information

Computation of Tax for Minor Children with Investment Income

This section should be completed for children with investment income who are filing their own return and
may be taxed at their parent’s effective tax rate. Please attach supporting statements.

Indicate parent’s filing status: A = Single, B = Married, filing jointly,C = Married, filing separately,

D = Head of household, E = Qualifying widow(er)
Parent’s name

L

8

If your minor child has siblings who are also under age 18 (under 24 if a full-time student) at the end of 2019 and

have unearned income, enter their names below. If we are not preparing the siblings returns, then also please

provide their 2018 unearned income.
2019 Unearned Income

1Interest &
Ordinary

Dividends
Net Capital

Gain
Investment

Interest Expense
Qualified
DividendsLast nameFirst name

9

10

11

12

Organizer Income Kid-tax Income Tax for Children

Parent’s Election to Report Child’s Interest and Dividends
This section should be completed for children with investment income which may be reported on the
parent’s return. Please attach supporting statements. (Forms 1099-B; 1099-DIV and 1099-INT)

1 2

Tax-exempt Total
DividendsLast nameFirst name Interest interest Capital gains

13

14

15

16

1 Please indicate amount of both short-term and long-term (including capital gain distribution).

2 Please indicate amount of qualified and non-qualified dividends.
Organizer Income Kid-tax Income Child’s Int. & Div.

R9012 2.000



Employee Compensation and Withholding

Wages and Salaries
Please enclose all copies of 2019 Forms W-2. Enter payments of 2019 estimated tax on the Payments of 2019 Federal, State & City

Estimated Tax organizer.
Box 1 Box 2 Box 4 Box 6 Box 17 Box 19

Indicate: T = Taxpayer, S = Spouse Federal Social State City
Wages income Security Medicare tax tax

L and tax tax tax withheld withheld
Employer’s name / Name of state Salaries withheld withheld withheld Name state*: Name state*:

1

2

3

4

5

6

7

8

9

10

TTotal (Lines 1-10)

Organizer Income Wages and Salaries Columnar Wages Entry

*if more than one state/city please list under "Other Federal, State and City Tax Withholdings" section below

Other Wage Information

Other Federal, State and City Tax Withholdings
Do not duplicate elsewhere. Enter payments of 2019 estimated tax on the Payments of 2019 Federal, State & City Estimated Tax

organizer. Enter state and local income tax refunds on the Miscellaneous Income organizer.

Indicate: T = Taxpayer, S = Spouse, J = Joint
Name

L Description Federal State City/Local of state

11

12

13

14

T

Total (Lines 11-14)

Other W-2 Information

Taxpayer Spouse

If your employer provided any other economic benefit not reported

15excluding company provided fringe benefits, indicate the total amount

If any of the following income items were received, provide details on a continuation sheet:

%
tip income

% reimbursements in excess of expenses

%
professional fees

%
personal use of company automobile

discriminatory medical payments
%

Organizer Income Wages and Salaries Other Wage Withholding & Misc.

R9101 1.000

U0829700
See_A_B



Interest Income - 1099-INT

List all interest received per Forms 1099-INT or other information statements you received. Enter any early withdrawal penalties on the next page.

Please enclose copies of all 1099-INT’s, Schedules K-1, and other documents indicating interest received.

Q Include supplemental information provided by the broker for determining any modifications for state income tax purposes.
Include interest credited to your savings accounts during the year as of Dec. 31.
Include interest credited annually on dividends left on deposit with a life insurance company.
Do not list interest from Schedule K-1.

Q

Q

Q

Q

Q

If you’ve entered an amount in the Foreign Taxes Paid column, please enter foreign source income below and foreign country
on a Continuation Sheet.

Interest Income
Indicate: T = Taxpayer, S = Spouse, J = Joint

Enter "X" if state withholding is present

Box 1 Box 3 Box 4 Box 5 Box 6 - Box 8 - Box 9Box 1
L

Investment

Expenses

Foreign

Tax

Paid

Tax-exempt

Interest

Nonresident

Tax-Exempt

Interest

Specified

Private Activity

Bond Interest

PY

Amount

Interest on U.S.
Savings Bonds &

Treasury
Obligations

Foreign
Source
Interest
Income

Federal
Income

Tax
Withheld

Interest
Income not

Included
in Box 3

L Name of Payer

Total interest

Organizer Income Interest Income

Page 1

R9110 1.000

U0829700
See_C_D



Dividend Income - 1099-DIV

List all dividends received by you or for your account.

Please enclose copies of all 1099-DIV’s, Schedules K-1, and other documents indicating dividends received.

Q Include dividends left with a company to be reinvested in the company’s stock.

Q Do not include Credit Union Dividends here. They should be included on the Interest Income - 1099-INT organizer.

Q Do not include dividends received as a return of premiums from mutual insurance companies.

Q

Q

Do not list dividends from Schedules K-1.
If you’ve entered an amount in the Foreign Taxes Paid column, please enter foreign country and break out foreign qualified
dividends on a Continuation Sheet.

Dividends
Indicate: T = Taxpayer, S = Spouse, J = Joint

Enter "X" if state withholding is present

Box 11 Box 6Box 1a Box 1a Box 1b Box 2a - Box 2b Box 2c Box 3 Box 10 Box 5 -
L

U.S. Gov’t
Interest
incl. in

dividends

U.S. Gov’t
Interest
incl. in

dividends

Ordinary
Dividends

PY
Amount

Qualified
Dividends

Capital
Gain

distribution

Non-
taxable

distribution

Exempt-
interest

dividends

Unrecap.
sec. 1250

gain

Specified
Private
Activity

Foreign
Tax
Paid

Foreign
Source

Dividend
Income

Sec. 1202
gain

Investment
expenses

L Name of Payer

Total dividends

Organizer Income Dividend Income

R9102 1.000

U0829700
See_E_F



Schedule C - Profit or Loss from Business or Profession

Activity Information
Indicate: T = Taxpayer, S = Spouse, J= Joint 1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

T

20

21

22

23

24

25

26

27

T

28

29

30

31

T

32

Business name

Street

City, state, zip, country

Principal business/profession

Employer identification number Tax shelter ID number Tax shelter registration number

Accounting Method
Indicate method of accounting: A = Accrual, O = Other, Blank = Cash, B = Leave unanswered

If other (specify)

Inventory Valuation
Indicate method of inventory valuation: (If "other", please provide explanation on a continuation sheet.)

C = Cost, L = Lower of cost or market, O = Other, D = Not applicable
X if there was any change in determining quantities, cost, or valuation of inventories

Miscellaneous Information

Indicate X if this business was started or acquired during 2019

Indicate X if you received earnings as a statutory employee

Indicate X if the business was disposed of in 2019

Indicate X if the business was ever audited by IRS, State, or Foreign Tax Authority

Year of audit

Indicate X if you made any payments in 2019 that would require you to file Form(s) 1099

Indicate X if you filed all required Form(s) 1099

Organizer Income Business Income Business Information Sch. C Activity InformationBusiness Name

Income
Gross Receipts or Sales 2019 amount PY amount

Total or override

Returns & allowances

Cost of Goods Sold and/or Operations PY amount2019 amount

Inventory at beginning of year

Purchases less cost of items withdrawn for personal use

Cost of labor

Materials and supplies

Other costs related to inventory

Inventory at end of year
Total cost of goods sold and/or operations

Reimbursements
Meals and Entertainment

Other reimbursements

Other Income
PY amount2019 amount

Total other income (Lines 29-30)

Portfolio Income

Organizer Income Business Income Business Name Business Information Income/Expenses
Page 1R9121 6.000

U0829700
See_H

U0829700
See_I

U0829700
See_I



Schedule C - Profit or Loss from Business or Profession
Business name:

Expenses

2019 amount PY amount

Advertising 32

(Do not duplicate expenses listed on the vehicle business
expense schedule page)Car and truck expenses 33

Commissions and fees

Contract Labor

34

35

Employee benefit programs 36

Insurance (other than health insurance) 37

Mortgage interest paid to financial institutions 38

39

40

41

42

43

44

45

46

47

48

49

50

51

52

53

54

55

56

57

58

59

60

61

62

63

T

64

65

66

If amount is entered, please attach details and required bank documents.

Other interest

Legal and professional services

Office expenses postage, etc.

Pension and profit-sharing plans

Machinery and equipment rent

Other business property rent

Repairs and maintenance

Supplies

Taxes and licenses

Travel

Meals & Entertainment & Overnight Meals (gross amount subject to limitation)

Utilities

Wages (gross)

Total expenses (Lines 32-51)

Indicate X if you were subject to the Department of Transportation hours of service limits

Other Expenses

PY amount2019 amount

Local transportation including train, cabs, bus, etc.

Overnight travel expense (lodging, car rental, taxi, etc. excluding meals)

Telephone

Professional dues

Stationery, postage

Professional magazines, journals

Other expenses (e.g. uniforms required as condition of employment)

Total (Lines 53-63)

Domestic Production Deduction - Sec. 199A
2019 PY

-

-

-

Qualified Business Income

Specified Service Trade of Business

If there were wages paid to employees, provide a copy of Form W-3 filed for this activity

Organizer Income Business Income Business Name Business Information Income/Expenses

Page 2
R9122 2.000

U0829700
See_I



Schedule C - Profit or Loss from Business or Profession

Business name:

Depreciation and Amortization

Enter all property and equipment used in your business or profession. If you sold, traded, or otherwise
disposed of an asset, please provide the date sold and gross sales price. Please indicate in the notes
section if you would like to elect Section 179 expense for a particular asset placed in service in 2019.
For vehicle expenses, make your entries on the Business Expense Schedule and Form 2106 page,
and indicate Schedule C on the property type code.

DateDescription of property Date placed Cost or Gross salesBusiness
soldin service unadjusted priceuse

MM DD YYYYMM DD YYYY basis %

1

2

3

4

5

6

7

8

Total (Lines 1-8) T

For assets placed in service prior to 1/1/2019, please provide
a schedule of accumulated depreciation on a per asset basis.

New Clients:

If you had any amortization expenses (organizational costs, loan fees, etc.), for this business, provide
details (description, date purchased, cost, life, etc.) below:

9

10

11

12

Organizer Income Business Income Business Name Depreciation and Amortization Asset Detail

Notes:

R9123 1.000

U0829700
See_J



Capital Gains and Losses
Complete the following for each sale of stock, bonds; including municipals, mutual funds, or similar securities. Indicate the amount of any transfer taxes paid after the description.
The amounts shown on this form must reconcile to Form 1099-B.

Q

Q

Q

Q

Q

If any sales were transacted outside the U.S., provide the following details on a continuation sheet:
(a) the name of the country where the sale took place and
(b) information regarding any tax imposed on the sale by that country.
If you had an installment sale in 2019, provide that information on a continuation sheet. For installment sales prior to 2019, use the Installment Sales form.
If you had a like-kind transaction (section 1031) during 2019, please provide details below and additional details on a continuation sheet.
Dispositions of depreciable business assets should be shown on Business, Farm or Rental income forms or on a continuation sheet.
Include cost basis statements for capital gain transactions, if not included in broker’s statements referenced in the note below.

Please enclose all broker’s statements (i.e. Form(s) 1099-B or equivalent statement such as broker’s confirmation statement) for purchases and sales of stock.

Sales of Stocks, Bonds, etc.
Indicate: T = Taxpayer, S = Spouse, J = Joint

Indicate: A = Transaction is reflected on Form 1099B with proceeds and basis (covered), B = Transaction is reflected
on Form 1099B with only proceeds (non-covered), C = Transaction is not reported on Form 1099B

Date
acquired

MM/DD/YYYY

Date sold or
date worthless*
MM/DD/YYYY

Sales proceeds
net of selling

expense
Cost or

other basis

Adjustments
before

limitations Code
LT
STL L Number of shares and company name

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

T

GT

25

26

27

Total (Lines 1 - 24)

Net Gain/Loss

Indicate X if you owned any securities which became worthless during 2019

*(Also provide on a continuation sheet how it was determined to be worthless.)

Indicate X if you re-purchased securities within 30 days before or after the sale of any securities from the same company or fund within any taxable or nontaxable account. If so, provide details on Continuation sheet.

Indicate X if you engaged in any collar transactions during 2019. If so, provide details on Continuation sheet.

Organizer Gains And Losses Capital Gains And Losses
R9220 1.000

U0829700
See_note_F_G

U0829700
See_F

U0829700
See_G



Interest Expense

Home Mortgage Interest Expense (include Prepayment Penalties and Late Fees)
(Enclose mortgage statement/settlement sheet if home was purchased, refinanced, or sold in 2019. Do not include interest paid shown
on the Rental and Royalty Income and Expense organizer or the Vacation Home organizer or the Office-in-Home organizer.)

Form 1098 - Mortgage Interest and Taxes (Name of Lender)
2019 amount PY amount

X if home equity line/loan 1

2

3

4

5

6

Mortgage interest received from payer(s)/borrower(s) (Box 1)

Points paid on purchase of principal residence (Box 6)

Refund of overpaid interest (Box 4)

Qualified Mortgage Insurance Premiums (Box 5)

Real estate taxes paid or other amount shown
Organizer Source Documents Form 1098 - Mortgage Interest & Taxes Form 1098 - Mortgage Interest & Taxes

Form 1098 - Mortgage Interest and Taxes (Name of Lender)
(Enter any additional Form 1098 information on a continuation sheet)

X if home equity line/loan 7

8

9

10

11

12

Mortgage interest received from payer(s)/borrower(s) (Box 1)

Points paid on purchase of principal residence (Box 6)

Refund of overpaid interest (Box 4)

Qualified Mortgage Insurance Premiums (Box 5)

Real estate taxes paid or other amount shown
Organizer Source Documents Form 1098 - Mortgage Interest & Taxes Form 1098 - Mortgage Interest & Taxes

Other Mortgage Interest Not Reported on Form 1098
Indicate: T = Taxpayer,S = Spouse, J = Joint PY amount2019 amount

13

14

TTotal (Lines 13 - 14)
Organizer Itemized Deductions Taxes and Interest Interest - Other

Points Not Reported on Form 1098
Start date of loan Life of loan in years 2019 Points Paid PY amount

X if loan is a refinancing 15

Itemized Deductions Taxes and Interest Interest - Points Paid No 1098Organizer

Mortgage Interest Paid To an Individual
I confirm this loan has properly

been recorded

SSNName

16

17

Address

Organizer Itemized Deductions Taxes and Interest Interest - Paid to Individual

Other Mortgage Information
If your home acquisition debt (mortgages to buy, build, or improve your principal home and one other
residence) totaled $1 million or more at any time during 2019 ($500,000 if married filing separately) or
your home equity debt totaled $100,000 or more at any time during 2018 ($50,000 if married filing
separately), provide balances below.

Loan 1 Loan 2 Loan 3 Loan 4

18

19

20

21

Name of Lender

Jan 1 Beginning Balance

Dec 31 Ending Balance

Interest paid per Form 1098

If you meet the requirements listed above and you borrowed any new amounts on a mortgage this year,
you prepaid more than one month’s principal, or you did not make level payments at fixed intervals, also
provide all monthly loan statements.

Investment Interest Expense
2019 amount PY amount

Include margin loan interest paid to purchase securities

22

23

TTotal (Lines 22 - 23)
Organizer Itemized Deductions Taxes and Interest Investment Interest Expense

R9403 2.000

U0829700
See_K



Charitable Contributions & Misc. Itemized Deductions

Contributions
Cash Contributions
List only contributions to United States or Canadian organized charities. Include payroll deduction amounts for 2019. Keep written receipts
from donee organization, canceled checks or payroll pledge card to substantiate contributions. Each contribution of $250 or more requires
written acknowledgment of the contribution from the charitable organization - cancelled checks are not considered adequate substantiation
for this purpose. Do not include political contributions. Reduce any contribution
made by the value of any benefit received; i.e. meals, merchandise.

prep. use only
30%
60%
100%

2019 Amount PY amountName of organization:

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

T

16

17

18

19

20

21

22

23

24

T

Total (Lines 1 - 15)

Volunteer Expenses

Standard charitable miles Jan - Dec

Actual gas/oil, expenses incurred

Parking fees/tolls

Organizer Itemized Deductions Contributions Contributions - CY and Carryovers

Miscellaneous Deductions
2019 amount PY amount

Amortized Bond Premium:

Claim Repayments:

Unrecovered Pension Investments:

Gambling losses (not to exceed gambling winnings)

Total (Lines 25 - 30)
Itemized Deductions MiscellaneousOrganizer

R9421 2.000

U0829700
See_L_M_N



a  Employee’s social security number

OMB No. 1545-0008

Safe, accurate, 
FAST! Use

Visit the IRS website at 
www.irs.gov/efile 

b  Employer identification number (EIN)

c  Employer’s name, address, and ZIP code

d  Control number

e  Employee’s first name and initial Last name Suff.

f  Employee’s address and ZIP code

1   Wages, tips, other compensation 2   Federal income tax withheld

3   Social security wages 4   Social security tax withheld

5   Medicare wages and tips 6   Medicare tax withheld

7   Social security tips 8   Allocated tips

9  10   Dependent care benefits

11   Nonqualified plans 12a  See instructions for box 12
C
o 
d 
e

12b
C
o 
d 
e

12c
C
o 
d 
e

12d
C
o 
d 
e

13 Statutory 
employee

Retirement 
plan

Third-party 
sick pay

14  Other

15  State Employer’s state ID number 16  State wages, tips, etc. 17  State income tax 18  Local wages, tips, etc. 19  Local income tax 20  Locality name

Form W-2 Wage and Tax 
Statement 2019

Department of the Treasury—Internal Revenue Service

Copy B—To Be Filed With Employee’s FEDERAL Tax Return. 
This information is being furnished to the Internal Revenue Service.

U0829700
Exhibit-A



     

a  Employee’s social security number

OMB No. 1545-0008

Safe, accurate, 
FAST! Use

Visit the IRS website at 
www.irs.gov/efile 

b  Employer identification number (EIN)

c  Employer’s name, address, and ZIP code

d  Control number

e  Employee’s first name and initial Last name Suff.

f  Employee’s address and ZIP code

1   Wages, tips, other compensation 2   Federal income tax withheld

3   Social security wages 4   Social security tax withheld

5   Medicare wages and tips 6   Medicare tax withheld

7   Social security tips 8   Allocated tips

9  10   Dependent care benefits

11   Nonqualified plans 12a  See instructions for box 12
C
o 
d 
e

12b
C
o 
d 
e

12c
C
o 
d 
e

12d
C
o 
d 
e

13 Statutory 
employee

Retirement 
plan

Third-party 
sick pay

14  Other

15  State Employer’s state ID number 16  State wages, tips, etc. 17  State income tax 18  Local wages, tips, etc. 19  Local income tax 20  Locality name

Form W-2 Wage and Tax 
Statement 2019

Department of the Treasury—Internal Revenue Service

Copy B—To Be Filed With Employee’s FEDERAL Tax Return. 
This information is being furnished to the Internal Revenue Service.

U0829700
Exhibit_B



     

Form 1099-INT

2019 Interest 
Income

Copy B

For Recipient

Department of the Treasury - Internal Revenue Service

This is important tax 
information and is 

being furnished to the 
IRS. If you are 

required to file a 
return, a negligence 

penalty or other 
sanction may be 

 imposed on you if 
this income is 

taxable and the IRS 
determines that it has 

not been reported.

OMB No. 1545-0112

CORRECTED (if checked)
PAYER’S name, street address, city or town, state or province, country, ZIP 
or foreign postal code, and telephone no.

PAYER’S TIN RECIPIENT’S TIN

RECIPIENT’S name

Street address (including apt. no.)

City or town, state or province, country, and ZIP or foreign postal code

FATCA filing 
requirement

Account number (see instructions)

Payer's RTN (optional)

1 Interest income

$
2 Early withdrawal penalty

$
3 Interest on U.S. Savings Bonds and Treas. obligations

$
4 Federal income tax withheld

$
5 Investment expenses

$
6 Foreign tax paid

$
7 Foreign country or U.S. possession

8 Tax-exempt interest

$

9  Specified private activity bond 
interest

$
10 Market discount

$

11 Bond premium

$
12 Bond premium on Treasury obligations

$
13 Bond premium on tax-exempt bond

$
14 Tax-exempt and tax credit 

bond CUSIP no.
15 State 16 State identification no. 17 State tax withheld

$
$

Form 1099-INT (keep for your records) www.irs.gov/Form1099INT

U0829700
Exhibit_C



     

Form 1099-INT

2019 Interest 
Income

Copy B

For Recipient

Department of the Treasury - Internal Revenue Service

This is important tax 
information and is 

being furnished to the 
IRS. If you are 

required to file a 
return, a negligence 

penalty or other 
sanction may be 

 imposed on you if 
this income is 

taxable and the IRS 
determines that it has 

not been reported.

OMB No. 1545-0112

CORRECTED (if checked)
PAYER’S name, street address, city or town, state or province, country, ZIP 
or foreign postal code, and telephone no.

PAYER’S TIN RECIPIENT’S TIN

RECIPIENT’S name

Street address (including apt. no.)

City or town, state or province, country, and ZIP or foreign postal code

FATCA filing 
requirement

Account number (see instructions)

Payer's RTN (optional)

1 Interest income

$
2 Early withdrawal penalty

$
3 Interest on U.S. Savings Bonds and Treas. obligations

$
4 Federal income tax withheld

$
5 Investment expenses

$
6 Foreign tax paid

$
7 Foreign country or U.S. possession

8 Tax-exempt interest

$

9  Specified private activity bond 
interest

$
10 Market discount

$

11 Bond premium

$
12 Bond premium on Treasury obligations

$
13 Bond premium on tax-exempt bond

$
14 Tax-exempt and tax credit 

bond CUSIP no.
15 State 16 State identification no. 17 State tax withheld

$
$

Form 1099-INT (keep for your records) www.irs.gov/Form1099INT

U0829700
Exhibit_D



     

Form  1099-DIV 

2019 Dividends and 
Distributions 

Copy B 
For Recipient 

Department of the Treasury - Internal Revenue Service

This is important tax 
information and is 
being furnished to 
the IRS. If you are 

required to file a 
return, a negligence 

penalty or other 
sanction may be 

imposed on you if 
 this income is taxable 

and the IRS 
determines that it has 

not been reported. 

OMB No. 1545-0110 

CORRECTED (if checked)
PAYER’S name, street address, city or town, state or province, country, ZIP 
or foreign postal code, and telephone no. 

PAYER’S TIN RECIPIENT’S TIN

RECIPIENT’S name 

Street address (including apt. no.) 

City or town, state or province, country, and ZIP or foreign postal code

FATCA filing 
requirement

Account number (see instructions) 

1a  Total ordinary dividends 

$ 
1b  Qualified dividends

$ 
2a  Total capital gain distr.

$ 
2b  Unrecap. Sec. 1250 gain 

$ 
2c  Section 1202 gain 

$ 

2d  Collectibles (28%) gain 

$ 
3    Nondividend distributions 

$ 
4    Federal income tax withheld 

$ 
5    Section 199A dividends

$ 
6    Investment expenses 

$ 
7    Foreign tax paid 

$ 

8    Foreign country or U.S. possession

9    Cash liquidation distributions

$ 
10   Noncash liquidation distributions 

$ 
11  Exempt-interest dividends

$ 

12  Specified private activity 
bond interest dividends

$ 
13  State 14  State identification no. 15  State tax withheld

$ 
$ 

Form 1099-DIV (keep for your records) www.irs.gov/Form1099DIV
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      2019 CONSOLIDATED FORM 1099 
 
Hyte Fund         Frank & Marilyn Carson 
211 Lexington Drive      5473 W. Second Avenue 
Minneapolis, MN 55417      Minneapolis, MN 55417 
612-555-5555          612-111-1111  
      
      

   PAYER’S FEDERAL ID NUMBER                              RECIPIENT’S ID NUMBER 
       75-909090                845-52-8589 
 
 
 2019 FORM 1099-INT: INTEREST INCOME 

(BOX)    (AMOUNT) 
1. INTEREST INCOME NOT INCLUDED IN BOX 3      0.00 
2. EARLY WITHDRAWL ON PENALTY       0.00 
3. INTEREST ON US SAVINGS BONDS & TREASURY OBLIGATIONS       0.00 
4. FEDERAL INCOME TAX WITHHELD       0.00 
5. INVESTMENT EXPENSE       0.00 
6. FOREIGN TAX PAID       0.00 
7. FOREIGN COUNTRY OR U.S.  POSSESSION     - - - - - - - 

 
 2019 FORM 1099-DIV: DIVIDENDS & DISTRIBUTIONS 

(BOX)    (AMOUNT) 

1a. TOTAL ORDINARY DIVIDENDS    12.00 
1b. QUALIFIED DIVIDENDS      0.00 
2a. TOTAL CAPITAL GAIN DISTRIBUTIONS   276.00 
2b. UNRECAPTURED SECTION 1250 GAIN       0.00 
2c.  SECTION 1202 GAIN       0.00 
2d. COLLECTIBLES (28%) GAIN       0.00 
3. NONDIVIDEND DISTRIBUTIONS       0.00 
4.  FEDERAL INCOME TAX WITHHELD       0.00 
5. 
6. 
7. 
8. 
9. 

 

INVESTMENT EXPENSE 
FOREIGN TAX PAID 
FOREIGN COUNTY OR US. POSSESSION 
CASH LIQUIDATION 
NONCASH LIQUIDATION 

     0.00 
   0.00 

 NONE 
    0.00 
    0.00 

 

 
 2019 FORM 1099-B: PROCEEDS FROM BROKER & BARTER EXCH. TRANSACTIONS 

DATE DESCRIPTION SHARES PROCEEDS STOCK, BONDS, ETC FED TAX WITHHELD 
     
  03/01 VARIOUS STOCK  100     345.00 0.00 
     
 9/15 HYTE FUND   200   1,586.00  0.00 

     
 TOTAL    1,931.00  0.00 
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      2019 CONSOLIDATED FORM 1099 
 
Hyte Fund       Frank & Marilyn Carson 
211 Lexington Drive      5473 W. Second Avenue 
Minneapolis, MN 55417      Minneapolis, MN 55417 
612-555-5555          612-111-1111  

      
       PAYER’S FEDERAL ID NUMBER                              RECIPIENT’S ID NUMBER 
       75-909090                845-52-8589 
 
 
  
 LONG TERM CAPITAL GAINS/LOSSES 

DATE 
ACQUIRED 

 DATE 
SOLD 

SHARES 
SOLD 

DESCRIPTION PROCEEDS PURCHASE PRICE 

      
12/5/2014 3/1/2019 100                  VARIOUS 345.00     427.00 

      
4/17/2009 9/15/2019 200                  HYTE FUND         1,586.00 1,493.00 

      
   TOTAL 1,931.00 1,920.00 

 
 
  
    
 
 
 
 
 
 
 
 
 
 
 



 1

 
444 W. 44th Street 

New York, NY 10004 
555-555-5555 

Frank & Marilyn Carson 
5473 W. Second Avenue 
Minneapolis, MN 55417 
612-111-1111 
 
       PAYER’S FEDERAL ID NUMBER                         RECIPIENT’S ID NUMBER 
       77-221122                845-52-8589 
 
 
In 2019, you completed the following transaction with New Dimensions.  This transaction is 
recorded with the IRS. Please notify us immediately if any discrepancies exist.   
  
 
 

DATE 
ACQUIRED 

DATE 
SOLD 

SHARES 
SOLD 

DESCRIPTION PROCEEDS PURCHASE 
PRICE 

      
03/05/2012 08/01/2019 100 NEW DIMENSIONS FUND 1,204.00 896.00 

 
      

 
      
    
 
 
 
 
 
 
 
 
 
 
 

U0829700
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Activity Number 100
Owner Spouse
Business Name Craftiques, Inc
Address 5473 W. Second Avenue

Minneapolis, MN 55417
Employer ID number 12-2382721
Principal Business code 453220
Inventory Valuation Cost
Business Started 4/15/2019

SCHEDULE C

U0829700
Exhibit_H



Revenue
Gross Sales 19,150.00$ 
Less: Sales Returns and Allowances 0.00
Net Sales 19,150.00$ 

Cost of Goods sold
Beginning Inventory 0.00
Add: Purchases 9,750.00$   

Direct Labor 0.00
Gross Available for Sale 9,750.00$   
Less: Ending Inventory (2,975.00)$  
Cost of Goods Sold 6,775.00$   

Gross Profit (Loss) 12,375.00$ 

Expenses
Advertising 100.00$      
Depreciation 375.00$      
Insurance 550.00$      
Legal and Professional Services 400.00$      
Total Expenses 1,425.00$   

Net Income/loss 10,950.00$ 

The total of depreciation should not be entered, but should be calculated based on asset detail entered.

Craftiques
Income Statement

For the Year Ended December 31, 2019

U0829700
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A+ Computers 
The Best Computers for less 
 
1525 Main St. 
Minneapolis, MN 55417 
Phone 999.999.9011  Fax 999.999.9012 

INVOICE 

 
SOLD TO: 
Craftiques 
758 Millway Dr. 
Minneapolis, MN 55417 
 

SHIP TO:                                            INVOICE # 002-004 
Pick-up                                           INVOICE DATE: April 15, 2019 

 

Date Order # Sale Rep Ship Via Terms Customer ID 

04/15/2019 01-654 John Doe Pick-up Net 5467 

 
 

QUANTITY ITEM DESCRIPTION 
UNIT 
PRICE 

TOTAL 

1 Laptop Computer ACME 1000 XII $2,500.00 $2,500.00 

     

     

     

     

     

     

     

     

     

   $2,500.00 

Remittance $2,500 4/15/2019   

Amount Due: - 0 -   
 TOTAL DUE $2,500.00 
 
 
 
 

 
Notes to Preparer: 
Computer is used for Craftiques Business. 
Mrs. Carson plans to keep the laptop computer for five years for business/ 
personal purposes. 
Depreciation method: 5 years MACRS 

U0829700
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Form  1098

2019 Mortgage 
Interest 

Statement

Copy B 
 For Payer/ 

Borrower

Department of the Treasury - Internal Revenue Service

The information in boxes 1 
through 9 and 11 is important 

tax information and is being 
furnished to the IRS. If you are 

required  to file a return, a 
negligence penalty or other 

sanction may be imposed on 
you if the  IRS determines that 

an underpayment of tax 
results because you 

overstated a deduction for 
this mortgage interest or for 

these points, reported in 
boxes 1 and 6; or because 

you didn’t report the refund of 
interest (box 4); or because 

you claimed a nondeductible 
item.

OMB No. 1545-1380

CORRECTED (if checked)
RECIPIENT’S/LENDER’S name, street address, city or town, state or 
province, country, ZIP or foreign postal code, and telephone no.

RECIPIENT’S/LENDER’S TIN PAYER’S/BORROWER’S TIN

PAYER’S/BORROWER’S name 

Street address (including apt. no.) 

City or town, state or province, country, and ZIP or foreign postal code

9 Number of properties securing the 
mortgage 

10 Other

Account number (see instructions)

*Caution: The amount shown may 
not be fully deductible by you. 
Limits based on the loan amount 
and the cost and value of the 
secured property may apply. Also, 
you may only deduct interest to the 
extent it was incurred by you, 
actually paid by you, and not 
reimbursed by another person.

1 Mortgage interest received from payer(s)/borrower(s)*

$ 
2 Outstanding mortgage 
principal

$ 

3 Mortgage origination date

4 Refund of overpaid  
interest

$ 

5 Mortgage insurance 
premiums

6 Points paid on purchase of principal residence

$

$
7        If address of property securing mortgage is the same     
as PAYER’S/BORROWER’S address, the box is checked, or 
the address or description is entered in box 8.

8 Address or description of property securing mortgage (see 
instructions)

11 Mortgage acquisition 
date

Form 1098 (Keep for your records) www.irs.gov/Form1098
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United Way Campaign Pledge Receipt 
 
To:    Frank and Marilyn Carson 
         5473 W. Second Ave. 
         Minneapolis, MN 55417 
 
Cash received: $ 50.00      Date: 10/15/2019 
 
 
 
Thank you for supporting the United Way. 
 
 
 

U0829700
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Church of Faith 
Benefit Receipt 
 
 

To: Frank and Marilyn Carson    Cash Received $ 600.00 
5473 W. Second Avenue     Date of Contribution: 12/31/2019 
Minneapolis, MN 55417 
 
 
Church of Faith 

4355 Meadow Drive       Lucinda Jones 
Minneapolis, MN 55417       Secretary - Treasurer 
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From the Desk of Frank B. Carson 

 

 

Miscellaneous Cash Contributions for 2019 

 

 

 

American Red Cross  $   50.00 

Boy Scouts                   40.00 

Local school drive       25.00 

Girl Scouts                    10.00 

 

U0829700
Exhibit_N


	Chapter 1: Carson Case Study Guide
	Introduction

	Chapter 2: Carson Tax Return Scenario
	The Organizer Booklet
	Items To Note

	Chapter 3: Screen Components
	Forms List Window
	Organizer Screen
	Tax Forms Screen

	Chapter 4: Data Entry
	Organizer Booklet
	Source Documents
	Entering Information
	Basic Return Information
	Employer Information
	Wage Income
	Interest and Dividend Information
	Capital Gains and Losses
	Schedule C Business Information
	Schedule C Business Income and Expenses
	Mortgage Interest and Real Estate Taxes
	Charitable Contributions


	Chapter 5: Reviewing the Return
	Diagnostics
	Viewing Diagnostics
	Suppressing Diagnostics

	Overrides
	Clearing Overrides
	Deleting Overrides

	Comparison
	Printing the Carson Return
	Printing from Print Preview
	Selective Printing from Print Preview


	Chapter 6: Creating Training Returns
	Chapter 7: 1040 Carson Case Study Facts (CASCAM)
	Targeted Areas
	Data Entry Areas
	Return Information
	Taxpayer Information
	Dependent Information
	W-2 Information

	Income Information
	Interest Income
	Dividend Income
	Business Information
	Depreciation Information
	Capital Gains and Losses

	Itemized Deductions
	Filing Instructions

	Carson Case Study Organizer Source Documents

